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Electronic Bidding for MoDOT Road & Bridge Construction Projects 
Introduction 
These instructions will guide you through the electronic bidding tools available to contractors to assist 
in obtaining information about MoDOT bid openings and to submit bids via the Internet.  Submitting 
bids via the internet helps ensure that your bids are error free and submitted on time. 
 
MoDOT Website 
1. Go to www.modot.org or www.modot.mo.gov  
2. From the homepage - click on Bidding & Contracting on the left or Bidding Opportunities to             
get to Roadway and Bridge bidding opportunities. 
 

 
 
 

Click on Roadway Improvement Projects Administered by MoDOT  to get to the Bid 
Opening Info page where you fill find timely information about monthly road and bridge projects. 
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General Information – contains information such as:  Special Notices to contractors, bid opening 
dates, unit bid price book, and links to other web sites related to bid openings. 
 
View Specific Letting Information – all pertinent pre  and post bid opening information for 
projects.  This includes Notice of Bid Openings, Wage Rates, Planholder List, Electronic Bid 
Submission (EBS) Files and addendums.  The Post-Letting tab will contain Bids as Read, Bid 
Tabulations and Bid Award Summary after Commission approval. 
 
Tentative Letting Schedule – tentative schedule of MoDOT’s upcoming road and bridge projects. 
Pre-Bid Notices – any current meeting notices. 
Online Plans Room – the link to Indox – MoDOT’s electronic plans room. 
Electronic Bidding Service (Bid Express)  - the electronic bidding service that MoDOT uses to 
accept bids via the internet.     
 
Electronic Business Information – a “How-To” Guide, required forms, etc, along with Expedite 
Bid Software which is used to enter and submit bids electronically. MoDOT’s current version of 
Expedite Bid can be downloaded from MoDOT’s website or from the Bid Express website.  
(www.bidx.com).   
 
Also contained on this front page:  Local Public Agency (usually City and County) 
advertisements, Wage Rate Information, How to become a MoDOT vendor information, 
Disadvantaged Business Enterprise information and Design Build Information for any of MoDOT’s 
design build projects. 
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Bid Express Website 

 
To Sign up for a BidX Account: 
1. Go to www.bidx.com and click the Join now!  hyperlink and follow the steps. BidX can also be 

accessed from MoDOT’s web page. 
 

 
 

 
 
2.  You must accept the Bid Express Subscriber Agreement in order to continue. 
3.  Fill out the Bid Express Subscriber Questionnaire. 
4.  Complete Bid Express Signup Form. This process requires a credit card for BidX billing 

procedures. 
 
To Download Expedite® Bid software from the Bid Express website: 
1.  Select Missouri from the home page. 
2.  From the “Utilities” tab, choose the link for the Expedite® Bid program. 
3.  Fill in the appropriate information. 
4.  Click on the Download Expedite® Bid link. 

 
Note: You will have to enter pertinent information upon using Expedite® the first time such as 
company name, agency and vender ID.  
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DIGITAL ID INSTRUCTIONS 
 

You must have an active Digital ID to use the internet bid submission and electronic 
verification of bid bonds.  *Please note it can take up to 5 business days to process and 
activate the ID from the date it is received by BidX.com.  Digital ID’s should be treated like a 
person’s signature.  If your company has more than one person authorized to sign bids your 
company will need to have an ID created for each person.  Only the person authorized to sign a 
bid should know the Digital ID password.  This person should be the one creating the Digital ID.  

 
To Create a Digital ID: 

1. Login to the Bid Express website. 
2. Scroll down the page and click on “Create or Manage Your Digital ID” located under the 

“Manage Your Account” section. 

 
3. Click on the “My Bidx” link at the top of the page if you do not see this upon logging in. 
4. Click on “Create a new Digital ID” link. 
5. Enter the name of the officer authorized to sign bids, enter the company name, select Missouri 

Department of Transportation and enter your bidder ID (vendor number). 
6. Check the box to agree to pay the one-time processing fee. 
7.  Check the next box once you have updated the company information in the Expedite Bid 

Software. 
8.  Click the “Generate” button. 
9. Enter the password for the ID.  (Please remember this password can never be changed or 

retrieved.  Therefore, write it down and keep it in a safe place.) 
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10. Print the registration form for the ID.  This form must be signed by the officer the ID was created 

for and it must be notarized.  Original hardcopy form must be sent to the Bidx.com team for 
processing at this address. 

 
 Bidx.com  
Attn: Bid Express Administration 
5700 SW 34th St., Suite 1235 
Gainesville, FL 32608-5371 

 
Once the ID is created, MoDOT will receive the information and will approve, deny or place the 
ID on hold.  To view the status of your ID, click on the “Create or Manage Your Digital ID” link 
from the “Manage Your Account” section and click on the status of the ID.  Before an ID is 
enabled, the Bidx.com team must receive the correct paperwork for the ID. 

 
Please allow up to 5 business days to process and enable your Digital ID once we have 
received your completed, notarized form.  You will be notified by e-mail when your Digital ID is 
enabled. 

 
If you have any questions, please contact the Bidx customer support team at (888) 352-BIDX (2439). 
 
Note:  If you forget your password, it is not possible for Bid Express or MoDOT to determine or 
recover either your Digital ID password or your Digital ID.  You will have to obtain another 
Digital ID and pay an additional  $100 processing fee. 
 
To Back-up your Digitial ID: 
1. Insert a blank cd. 
2. Select “Tools” from the Bid Menu. 
3. Select “Manage Digital ID's”. 
4. Highlight the Digital ID you would like to export. 
5. Select the “Export ID” Button. 
6. Save the file to a cd using the "Export Digital ID" Save-As Dialog Box that appears. 
7. Make multiple copies of the cd as desired and store the cd in a secure place like a safe or safety 

deposit box. 
 
Note:  Do not store your Digital ID password and your back-up Digital ID in the same place. 
 
If you want to submit bids from multiple pc machines, you may copy the Digital ID to each machine 
per the instructions given below.  Digital ID’s should be treated like a person’s signature.  If your 
company has more than one person authorized to sign bids your company will need to have 
ID’s created for each person.  
  
To copy your Digital ID to another PC: 
1.   Insert the cd containing your ID. 
2.  Select “Tools” from the Bid Menu. 
3. Select “Digital ID's”. 
4. Select the “Import ID” Button. 
5. Highlight the Digital ID you would like to import using the "Import Digital ID" Save-As Dialog Box 

that appears. 
6. Select the open button to import the Digital ID. 
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REQUEST TO SUBMIT BIDS ELECTRONICALLY IN MISSOURI 
 
1. The contractor must submit an executed “Request to Submit Bids Electronically” to MoDOT 

Design Division –ATTN: Electronic Bidding, P.O. Box 270, Jefferson City, MO 65102.  The 
agreement can be found at 
http://www.modot.mo.gov/business/contractor_resources/bid_opening_info/bidGenInfo.shtml. 

 

 
 
 
SUBMITTING ELECTRONIC BIDS IN MISSOURI 
 
Your company has to have an active BidX Account in order to submit bids via the Internet. 
  
MoDOT’s BidX Home Page   
1. After logging in - select  Missouri in the dropdown box and click GO. 
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2. From the “Lettings” tab, choose the specific letting you are interested in by double clicking  the 

date from the list. 
           

  
 

A. Each letting page contains a list of contracts as well as the dbe.bin file.  This file contains a 
listing of  DBE firms in the MRCC DBE directory.  (It must be saved in the same location 
as the EBS files that you are bidding on.)    

B. Double click on a specific contract ID to see a schedule of items, number of amendments, 
description, revision date, and to save the EBS file. 
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C. Click the Expedite Data File 22julB01.ebs  and save it to your computer.  Again, the EBS file 

and dbe.bin file must be saved in the same location on your computer. 
 
  Check for any amendments that may have been sent out for this proposal. Amendment files 

should be saved in the same location as the original EBS file. This will ensure that when the 
proposal is opened the amendments will also upload.   

 
USING EXPEDITE BID 
1. Select Open Proposal from the File menu. 
2. Find the location where you saved the EBS file and click on it. 
3. Select Open. 
4. Notice that when an amendment is saved in the same location as the original EBS file, 

Expedite® will notify you of the changes as shown below.          
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5. Click OK. 
6. Expedite® will open the Proposal and it should look like the screen below.  It will show the 

number of Amendments. 

 
 
7. Please note that the folders are initially RED. These folders will turn GREEN when all of the 

needed data is completed.  You can double check by clicking on the yellow check bid icon. 
 
NOTE:  If you are not submitting your DBE information electronically or are bidding on a project that 
does not contain a DBE goal, the DBE goals folder will not turn GREEN. 
 
TO FILL OUT THE INDIVIDUAL FOLDERS 
 
Schedule of Items Folder:  Complete the schedule of items screen by inputting the unit price of 
items.  Once all unit prices are entered, the folder will turn green. 
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Disadvantage Business Enterprise (DBE) Folder - For the DBE Goals folder to turn green, the 

following must be completed: 
a. A DBE goal page needs to be completed for each DBE that is used by clicking ADD DBE 

on the main DBE Goal page. 

 
 

b. Fill in the DBE Goal for the DBE as follows.   
c. NOTICE that fields marked with the ** are required fields and must be completed in order 

to get a green folder.  
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d. Select the DBE name from the dropdown list.  In order for this to work the DBE.BIN file 

must be downloaded from BIDX.com or MoDOT’s web site and saved with the 
original EBS file (See page 6 number 3). 

e. Select the type of work this DBE will do for you from the USED AS dropdown.  The options 
are Manufacturer, Subcontractor and Supplier.  The supplier option will be given a credit of 
60% credit of the dollar amount entered toward the DBE goal. 

f. Submit Quote:  Select whether or not the DBE submitted a quote to you. 
g. Quote:  Type in the dollar ($) amount that the DBE quoted.   
h. Select whether or not you will use the quote that the DBE submitted in Will Use Quote? 

(Only the items that the quote is accepted for will be used in the DBE Goal calculation). 
i. Each Line/Bid Item and dollar ($) amount that the DBE will be providing should be defined 

in the available boxes. 
 

DBE Certification Folder 
j. Select from the dropdown box whether the bid will be submitted by fax/e-mail or with the 

bid.  If submitting by fax/e-mail is selected then the folder will not turn green.  
k. If submitting by fax/e-mail an electronic DBE Submittal form is available at 

http://www.modot.mo.gov/business/contractor_resources/bid_opening_info/bidgeninfo.shtml 
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Contract Provisions Folder 
 

 
 
 

1. Select YES/NO for fuel price adjustment on all listed choices. 
2. Select YES/NO for Asphalt Cement Price Index or seal coat price index. 
3. Indicate dollar ($) amount for Maximum Monetary Value of award(s) if applicable. 
4. Select All or None/Separate if the project is a permitted combination. 
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5. Select YES/NO for 102.18 Certifications. 
6. List your state of domicile if outside of Missouri. 
7. Indicate address(es) for Missouri offices or places of business. 
8. Indicate that you acknowledge reading this and the folder will turn green.  
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Subcontractor Disclosure Folder: 
 

 
1. Bidder may submit subcontractor disclosure information electronically with the bid or up to 

3 business days following the letting by fax/e-mail.  If submitting electronically, the bidder 
shall list name of each Subcontractor in accordance with section 102. The electronic 
Subcontractor Disclosure form is available at 
http://www.modot.mo.gov/business/contractor_resources/bid_opening_info/bidgeninfo.shtml 

2. Select how this information will be submitted and the folder will turn green. 
 
Signature and Identity of Bidder Folder: 

 

 
 
1. Select YES/NO for Electronic Bid certification.  
2. If NO is selected then provide an explanation of refusal. 
3. Indicate whether you acknowledge reading this screen then the folder will turn green. 
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Bid Bond Screen Folder: 
In order to verify Bid Bonds electronically, contact Insure Vision or Surety 2000 to obtain an electronic  
project specific bid bond or annual bid bond ID. 

Insure Vision Technologies:  (818) 783-3460. 
Surety2000:  (800) 660-3263. 
 

 
      

 
 

1.   Provide surety agency Bidder ID and Contract ID. 
2.   Surety registers bid bond and provides Bond ID number. 
4. Select the form of payment - if submitting a paper annual bid bond the folder will turn 

green.  If submitting a paper project bid bond or cashier’s certified check, the folder will 
not turn green. 

5. Enter the Electronic Bid Bond ID given by the Surety Agency. 
6. Select the Surety registry agency. 
7. Bond percent must always be 5% for Missouri Contracts. 
8. Surety State should be left blank as it is automatically populated. 
9. Click Verify. 
10. Follow the Verification Wizard. 
11. Verify accuracy of Bid Bond form after bid is printed. Print Bid by going to File, Print. 
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To Submit Bid(s): 
Using Expedite® Bid 

1. Select Submit Bid from the Tools menu. 
2. Follow the instructions of the bid submission wizard to submit your bid. 

 

 
 

3. Store your Bid Submission Receipt in a secure place. 
 
Note: Each previously submitted bid is overwritten by the latest submittal. 
 
To View  or Withdraw Submitted Bids: 

1. In Expedite® Bid, from the Tools menu select View Submitted Bids. 
2. Follow the View Bids Wizard. 
3. At this point you will be able to view the bid(s) that you have submitted and/or withdraw the 

bid(s) by highlighting the desired bid(s) and clicking on the "Withdraw Bid" button. 
 

 
 

REPEAT THE ABOVE STEPS FOR EACH PROPOSAL BID. 
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Bids as Read - can be viewed on the BidX website or MoDOT’s website. 
 

1. In BidX, go to Missouri’s page and select the Lettings drop-down.  Pick the specific letting 
and click on Apparent Bid Results. 

2. From MoDOT’s website, select Bidding & Contracting then Roadway Improvement 
Projects administered by MoDOT.   

 
  

3.  Next click on View Specific Letting Information 
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4. Pick the correct date in the dropdown box and click on Submit.  Once the Bid Results have 

been posted, a Post-Letting folder will be available.  Click on it to get to the Bid Results.  
The Bid Tabulations and Letting Award Summary will also be posted here after the 
Commission Meeting. 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


